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To begin we will start with some of the very basics. To even use Microsoft 
Excel you need to know how to run it, save files, open files, know what the 
toolbars are, and get a general idea of the program. 

General Overview: 
Opening Microsoft Excel: 
We will start by opening Microsoft Excel: 
To Open Excel either click/double click on the icon on you desktop: 
If the Icon is not on your desktop you can see if it is in your Quick Launch 
 Toolbar: 
 
 
If both of these options fail you can check in your start menu under 
programs.  If you are using a Macintosh system Microsoft Excel will be 
located in either your Applications folder of somewhere on your Mac Hard 
Drive.  
 

The Toolbars: 
Now you know how to open and run Microsoft Excel lets learn about some of 
its toolbars.  Below are the numerous toolbars in Microsoft Excel and a 
useful description of each. To open a toolbar you must go to the view menu 
on the General Microsoft Office Toolbar, go to toolbars and choose the one 
you wish.  At the end of most of the toolbars there is a  this allows the 
customizing of the toolbar with more or less buttons. 
 

 
 The General Microsoft Office Toolbar. This toolbar allows the user to 
control all of the pieces of Microsoft Excel.  

• The File Menu allows the opening, closing, saving, and printing of the 
Excel workbook.   

• Edit is just what it says, you can undo, redo, cut, copy, paste, and find 
from this toolbar.   

• View controls the look and feel of Excel.  Insert allows you to add 
rows, columns, charts, symbols, text boxes, pictures, and clip are to 
your work.   

• The Format menu is very self explanatory; it allows the formatting of 
the cells, rows, and columns of Excel. 
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• Tools has the spell checker, formula checker, and the main options 
menu in it. 

• Data allows sorting of data, database functions, and other advanced 
features of Excel. 

• Window allows the controlling of the “windows” in Excel 
• Help, Help!, one of the best menus in Microsoft Excel, you can get all 

the assistance you need, turn on/off the Office Assistant, and many 
other things. 

 

 
The Standard Toolbar, this toolbar has a lot of the same functions as the 
file, edit, and insert menus.  The buttons will be described and used later. 
 

 
This is the Formatting Toolbar, it allows all the functions in the formatting 
menu and is easier to get at and control. 

•  This is the font formatting section of the 
toolbar.  It allows you to change the font of you text and numbers, as 
well as the size in points. 1point=1pixel. 

•  These buttons allow you to bold, italicize, and underline 
selected text and numbers. 

•  These buttons are the justification buttons. These buttons 
will move the selected text either to the left, center, or right, of the 
selected cell.   

• This is the merge and center button.  It allows the combining of 
two of more cells; it also will keep and move the data from the first 
selected cell to the center of the merged cells. Here is and example: 

• These are the special nu- 
mber formatting buttons.  The first turns all 
the numbers in the cell to the currency type  
of numbers. (I.E. You type 6 and you want  
it to say 6 Dollars, when selecting the number and clicking the $ it will 
turn it to “$6.00”.) The next button is the percentage button; it turns 
all numbers into their percentage equivalents (I.E. .66 to 66%). The 
next button puts commas in long sets of numbers, if not pushed the 
number 1 million would look like 1000000, not 1,000,000. The next two 
buttons increase and decrease the number of following decimal points. 
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(I.E. you type 5 and you want it to be 5.00, you would select “5” and 
push the increase decimal button twice. 

•  The indent buttons increase and decrease the amount of the 
indent in a cell.   

• These are the cell border and color buttons.  We will show 
you how these work a little later. 

• This is the font color button.  It allows the changing of the color 
of numbers and text.  

These toolbars are the most used, generally, and are all that we will cover.  
There are many other toolbars that can be used in Microsoft Excel.  You are 
generally encouraged to open up toolbars and see what they can do.  If you 
want more information on the different toolbars you can go to Microsoft 
Office help and look up toolbars or just ask to Microsoft Assistant about 
toolbars. 
 

Saving in Microsoft Excel: 
To save in Microsoft Excel is the same as in most Microsoft Products.  You 
can go to the file menu and click save as or save, click the save button on the 
standard toolbar, or push ctrl and “s” at the same time on your keyboard, 
and release.  There is a not so old saying that most people who use 
computers know is save many and save often.  We are using Microsoft 
Products and if you are using anything other than Windows 2000 and XP your 
system may crash and you can loose a whole document.  With the later 
versions of excel especially in 2000 and XP your document can be recovered 
if your computer crashes.  Do not count on this though. 
 

Changing the View in Excel: 
To change the view in Microsoft Excel there is the zoom function.  To use 
the zoom function you can use the zoom drop down on the standard toolbar 

 or go to view, down to zoom and choose how close you would like 
your view to be.  
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Difference between Worksheet and Sheet: 
The difference between a Worksheet and worksheet is quite simple.  If you 
notice one has the word book in it and one has sheet.  Just think of them as 
whey sound, a worksheet is part of a Worksheet.  When you save anything in 
Excel it saves the entire Worksheet. 
 

Worksheets: 
Creating and naming a worksheet: 

• To create a new worksheet in Excel you need to insert it.  To insert a 
worksheet you must go to the insert menu and click worksheet or 
right click on one of the worksheet tabs and click insert on the menu 
that pops up, then click worksheet. 

• To name a worksheet right click on one of the sheet tabs 
 and click rename.  Type in the name of the 

sheet you would like on the tab you right clicked on.   
•  

Navigating and Moving Worksheets: 
• There are two ways to navigate between sheets in Microsoft Excel 

you can wither scroll and click on the sheet you would like by clicking 
on its tab. You can also use the sheet navigation buttons . To 
navigate to the first sheet click the first button on the right.  To 
navigate to the last sheet click on the far right button.  To move one 
back or forward, click on the respective middle buttons.  

• To move a worksheet click and drag its tab to where you would like it 
to go. There is a demonstration video on the web site.  The address is 
listed at the end of this packet. 

Spreadsheet Overview: 
Columns and Rows: 
The best thing to remember to remember what a columns and row is that a 
column is vertical and a row horizontal. Below is a picture of worksheet which 
is also known as a spreadsheet. 
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If you notice all the columns have a letter on the top of them.  The rows also 
have a number.  These lists of rows and columns go on nearly infinitesimally. 
 

Cells: 
Cells are the heart of every spreadsheet.  They contain all the data and 
formatting.  If you don’t understand cells you will not understand 
spreadsheets or formulas.  Cells look like little boxes 
made up by rows and columns. These rows and columns  
give each cell a set of coordinates.  The columns set  
the letter in each columns and the row the number. 
The general format for cell coordinates is letter than 
number.  The first cell on the top left of the 
sheet is known as A1.  The next cell to the right is B1. To find the cell 
coordinates of any cell you can look at the “name box” in the upper left of 
the sheet.  It looks like this: . 
 

Navigating between cells: 
To navigate between cells either click on the desired cell or type its 
coordinates in the name box.   
 

Selecting Rows, Columns, and cells: 
• To select a row click on the number of the row.  Now the entire row is 

selected. 
• To select a column click on its number. 
• To select multiple rows or columns click on the first row or column and 

hold down ctrl, while ctrl is being held click on the other rows or 
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columns you wish to select.  To select a consecutive group of rows or 
columns click the first one and hold down shift, while holding click the 
last one in the group, it will select all the columns or rows between. 

• To select a cell either click on it or type its coordinates in the name 
box.   

• To select multiple cells follow the same rules as the rows and columns. 
 

Resizing Columns and Rows: 
To resize a column just go to its edges like in the picture: . 

When you see this cursor “ ”click and drag the edge of the cell to the 
desired size.  To make the column as wide as the widest cell, double click 
when you get that cursor.  If you wish to manually resize a column with 
numbers right click on the column and click column width. To resize a row go 
to the number of the row and click on its edge like the following picture.  If 
you would like to set the height manually right click on the row and click row 
height.  
 

Formatting Cells: 
Using Borders: 
Now we start getting into some of the heart of Excel.  Borders are one of 
the things that make your spreadsheets look very professional and 
experienced.  To user borders can be difficult but Excel tries to help.  We 
will show this by example.  If you want a group of cells to all be boxed in like 
the illustration at right then you must first  
select the cells. Then click on the drop down  
arrow next to the borders button on the for- 
matting toolbar.  When the menu drops down  
click on the    .  .  This will make the selected  
cells have borders on all four sides. If you only  
want a cell to have a line on the bottom, select the cell, and in the borders 
drop down menu click        .  The rest of the borders are self explanatory. 
Borders do add to each other. If you did the borders to all four sides and 
the told one of those cells to have a bolded bottom, it will keep the thin lines 
on the top, left, and right, but bold the bottom. 
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Coloring Cells: 
To add color to a cell select the cells you would like colored, and the go to 
the cell color button.  Click the drop down arrow and choose the color. Then 
hit the button.  The cell color button is on the formatting toolbar and looks 

like this: .  It is right next to the borders button.  
 

Adding a Texture or Patterns to a Cell: 
To add a texture to a cell, select the cell. Then right click on it.  A menu will 
pop up, and click format cells.  A new window will pop up. Go to the patterns 
tab.  Choose a color for the pattern, and then click on the patterns button.  
A pop up window will open and choose your pattern. 
 

Cell Type/ Format: 
Each cell in your spreadsheet has a number format to it.  You can change 
this format many ways. One way is to choose one of the buttons from the 

format toolbar that looks like this: . The other way is to 
right click on the cell and click format cells.  A new window will appear and 
click on the Number tab.  You can choose any of those categories for the 
selected cells. 
 

Text: 
Typing Text: 
To add text to a cell just click on the cell and start typing.  It’s just like 
typing anything else except when you want to go back and edit it. 
 

Editing Text: 
To edit text either select the cell and double click on the text to change it 
or select the cell and change it in the formula bar. The formula bar will be 
introduced later. 
 

Formatting Text: 
To format text just select it, to select it, click on its cell and in the formula 
bar select it.  The other way is to double click in the cell and select it.  Once 
the text is selected you can choose its font and size on the formatting 
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toolbar.  To choose its color click on the far right button on the formatting 

toolbar that looks like .  Choose the drop down arrow next to it to 
choose the color and then hit the button.  
 

Numbers and Numerals: 
Adding and Editing Numbers: 
To add numbers to a cell follow the same rules as adding text.  The same 
rules apply for editing the numbers. 
 

Rounding: 
Microsoft Excel rounds off all extra decimal zeroes.  If you typed in 1.00 it 
would leave 1 in the cell.  To make sure the .00 is showing use the decimal 
place buttons on the formatting bar.  You can also set the number of decimal 
places by right clicking on the cell and clicking format cells.  In the window 
click the Number tab.  In the category list click number and set the number 
of decimal points. 
 

Formatting Numbers: 
Formatting numbers is the same as formatting text.  You can choose the 
font, size, and color. You can also give it a style like bold, italic, and 
underline. 
 

Using the Sum of (X) Button: 
Say you have a list of numbers in cells in a spreadsheet.  Wouldn’t it be nice 
if there was a button that would just add them all up, or find there average?  

There is, the  button.  This button has many functions;  
they are sum, count, average, max, min, and more.  To use it 
select the list of numbers either vertically or horizontally. 
But when you are selecting the list add another cell to it  
that is blank.  This is where it will put the sum, or count, etc. 
You can use this to sum or count entire rows by selecting  
the rows and choosing a blank one at the bottom. The same 
for columns. 
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Writing Formulas: 
The Formula Bar: 

 
The above image is the formatting bar in Microsoft Excel.  In this bar all 
the data in a cell is written.   
 
To use the formula bar and to write formulas you must remember some of 
you basic algebra.  In algebra you use variables to solve equations.  In Excel 
instead of using variables such as x, y, z, Excel uses cell coordinates. Also, 
instead of the equal sign being on its usual right side, it is the first thing on 
the left of the formula.  Here is an example of a simple equation. 

 
The X button, if clicked cancels your work. The check mark accepts your 
work.  The Fx button is for advanced functions, which we will not cover.   
To add to cells you use the addition sign “+”, to subtract “-“, multiply “*”, to 
divide “/”.   
 
Here is what happens when you write a formula for a cell like the one above: 
Before:                 After: 

              
 
You do not have to only add cells together; you can use constants as well.  
Say you want to add A1 to 16 and display the value in B1.  Click in B1 type in 
the following with out the quotes: “=A1+16”. 
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Making Charts and Graphs: 
Using the Chart and Graph Wizard: 
Below is a series of pictures from the Chart and Graph Wizard in Excel.  To 

start the wizard click the  button on the standard toolbar.   

 
As you can see there are many graphs to choose from.  We will choose the 
column graph for learning purposes.  The Office Assistant is very beneficial 
in this process.  To start the Assistant click the Help menu and click on 
Show the Office Assistant.   
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This is where you set the area of the data you will be using.  To set the area 

click the  and select the area. Under series you can choose the exact 
data you wish for the X axis and the different data.   
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• Now it asks you to choose the Charts Title, and the labels for the X 
and Y Axis. 

• The other tabs in this window control many of the other options of 
the chart.  Some of these options are things like gridlines, labels, and 
if you want a legend. There is a video on the website about making 
charts and graphs. 

 
Now you must choose the location of the chart.  You can either have it put in 
your current spreadsheet, or put it in as a sheet in the workbook.  We will 
put it in as a new page in the workbook. 
 
I used this data to make this graph: 
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Making Graphs and Charts are very easy in Excel. Now we will show how to 
put things like charts and graphs into other applications such as Microsoft 
Word, Microsoft PowerPoint. 
 

Transferring Data: 
Moving a spreadsheet to Microsoft Word: 
Let’s say you made the spreadsheet below, and you want to include it in a 
report about the birth rates in the Midwest.  How could you move this data 
with out making a table in Microsoft Word? 
 
Here’s One Way: 

1. Select the data 
2. Copy it by either using the  

button, the edit menu, or  
by hitting ctrl & C down  
together briefly. 

3. Go to your Word document 
4. Place your cursor where 

you would like the data 
and paste it by using the  
button, menu, or ctrl + v. 

Here is another: 
This will put the active sheets 
data into Word.  Meaning which- 
ever sheet was active when it was 
placed in Word will be displayed. 

1. Make sure the sheet you want to  
display is open in Excel and saved 

2. Open up word and place your  
cursor where you would like the data 

3. Go to the insert menu 
4. Click Object 
5. When that window opens click 

on the Create from File Tab 
6. Browse to your Microsoft  

Excel Workbook and click the  
insert button 
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7. Now click the Link to File Check  
Box and hit Ok 

8. The data should appear in Microsoft  
Word. 

This data can be changed in Excel and it will 
automatically change in Microsoft Word. 
 
 
 
 
 

Transferring Info to Microsoft PowerPoint: 
To transfer information to Microsoft PowerPoint and many of its other 
applications follow the same steps as if you were transferring it to 
Microsoft Word. 


